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Photoview – Introduction to the photometric measure ments management program 

  Notes  

Introduction to Photoview 

    LITESTAR 4D - Photoview is a program that processes 
the photometric data of lighting devices in graphs and tables. 

The photometric data can originate from any source, whether 
generated by a goniophotometer or acquired from external files in 
any public format and therefore modifiable throughout.   

Photoview is not only a powerful tool for the elaboration of 
photometric measurements according to the most recent 
international norms, but also a system for the preparation of 
catalogs able to reduce dramatically to a minimum the time for 
graphic elaboration taking advantage of the extreme flexibility of 
the available functions.  

Photometric Measurements Management 
Launch of the Photoview program activates the management 
window which is made up of the following parts: 

�� the Menu Bar situated in the upper area 

�� the ToolBar associated with the Menu Bar functions and 
situated below it 

�� a central part, on the right, reserved to the viewing of both the 
graphics and tables of the selected photometric measurement  

�� a central part, on the left, reserved to the tree diagram of 
photometric measurements currently viewed  

�� again in the central section, visualization of a polar graph 

�� a lower section where the general data of the product, the 
main characteristics of the measurement and the maximum 
dimensions are shown.  
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Tool Bar – Menu Bar 

  Notes  

The Menu Bar is made up of the following menus: 

�� File which includes graph and table print functions or their 
saving on file; 

�� Edit to manage editing functions such as the acquisition of an 
image or table in memory; 

�� Options for access to the configuration window of the 
program module 

�� View to manage the graph view functions 

�� Options that allows access to the information related to the 
version of the program 

 

File 
The File menu allows management of the following functions: 

�� Print All Preview: to view on screen everything about the 
active product that can be printed 

�� Print All: to print everything about the active product that can 
be printed 

�� Print Screen Preview: to view the print preview of what is 
currently on screen 

�� Print Screen: to print the current graph. Selection of the 
function opens the system window in which to select the print 
elements. Press OK to confirm 

�� Setup Custom Print: to define the group of tables and 
graphics to be printed. Just drag and drop one or more 
elements from the left-hand column to the right-hand column 
with the mouse, whereas to put them in order, just click on 
one element  of the right-hand column and move it in up or 
down. Press Del if you wish to eliminate an element from the 
right-hand column. 

�� Preview Custom Print: for a Print Screen preview of the list  
created with Setup Custom Print 

�� Custom Print to actually print the list created with Setup 
Custom Print 

�� Printer Setup for access to the system window for printer 
management 

�� Import file ....: this allows a photometry to be imported in 
Eulumdat, IES, TM14, OXL and Gonio formats. It is also 
possible to import a photometric file by using the Drag&Drop 
function: just drag&drop the file into the list of the 
photometries so that all data will be loaded and viewed.   

�� Save Image: to save the image (polar, Cartesian diagram ….) 
in an image in BMP, JPG, TGA, PCX or PNG format 

�� Save Text: to save the photometric matrix or the selected 
table in a .TXT file 

�� Save Photometry: in 3D DXF to save the matrix in a 3D DXF 
file to view the photometric solid with a CAD program 

�� Save Luminance: in 3D DXF, to save the graphic element in 
3D DXF format 

�� Save Page: as 2D DXF, to save the graphic element in 2D 
DXF format. 

�� Save Page: as 2D PostScript to save, where possible, the 
graph in EPS format 

�� Save photometric file…: allows you to save the current 
photometric measurement in one of the following formats: 
Eulumdat, IES and TM14, OXL and Gonio. 

�� Exit to quit the program 

�
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Tool Bar – Menu Bar  
  Notes  

Edit 
The Edit menu allows management of the following functions: 

�� Copy Image: to copy the active image (Cartesian, polar 
diagram etc.) in the temporary memory. This image can then 
be pasted onto a different graphic application 

�� Copy Window: Title to copy in the temporary memory the 
heading of the window corresponding with the description of 
the luminaire to be used with text applications 

�� Copy Table: to copy in the temporary memory the 
photometric matrix of the luminaire under examination to be 
used with text applications�

Options 
The Options menu contains the following three options:  

�� General Options… to access the window for module 
configuration management.  

�� Batch Options…this entry is useful for configuring batch 
functions management (automatic functions which are useful 
when it comes to repeating the same operations on other 
elements)  

�� Font Options…: to activate the viewing and printing font 
definition window. In this way it is possible to define:  

· the Style Type To Use On Screen between Use Vectors 
and Use Bitmap Raster 

· the Style to Modify:  double-click on one of the elements 
that appear on the list on the left to define font style and 
size, then press OK to confirm. The different viewing and 
printing modes appear on the left of the list: it is possible, 
in fact, to define a font style and a size for each of the 
available options. For each option the active setting is 
shown on the right.   

· Load Style… and Save Style…: in this case it is possible 
to load and add a new style to the already existing ones.  

�
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Tool Bar – Menu Bar  
  Notes  

General Options 
From the General Options window it is possible to configure the 
following elements: 

�� Print Language: to choose the language to be used for graph 
and table printouts  

�� Video Language: to choose the language with which to 
manage the Photoview program on screen  

�� Image Height [pixels]: to define the number of pixels for the 
height of the image 

�� E/PS options: to set the Line width scaler with which to export 
the diagram  

�� Text Separator: to define the text separating characters, with 
the possibility to choose between space, tab and semicolon 

�� Decimal Separator in Exporting: to define the choice between 
dot(.) and comma (,)with which to export the numeric 
measurements   

�� Default Units: to define the measurement unit for visualizing 
graphs and tables whether candela [cd] or candela on lumen 
[cd/klm] 

�� Page Numbering: to define the number of the first page to be 
printed; page numbering can only be defined if the relative 
field is editable 

�� Suggested filename length: allows the use of file names that 
are made up of more than 8 characters compatible with 
operating systems from XP onwards or according to the 8+3 
pattern used by DOS system   

�� Line Widths: for curves, grids and isolux curves 

�� Default Line Type: to set the line type (solid, dashed, dotted, 
dot dashed, long dashed) of orthogonal C0°-180° and  C90°-
270° curves and of C-90° semiplanes for road lighti ng 
luminaires and determine the color�

�� IESNA Import Options allows rotation of the photometric 
curve when it has been created with an inverted system of 
coordinates 

�� Fill Color to activate both filling color and grid color  

�� C90/270 left/right to invert graph view 

�� Measurement System to set the unit of measurement to be 
used according to either I.S. Units or North American Units 

�� Cartesian Labels to indicate whether the labels of the 
cartesian diagram are to be recorded in the inner or outer 
graph area 

�� Beam Options: to define the default value for the opening of 
the luminous beam  

�� Default App Height: to define the default height for the 
installation of the luminaire in isolux curves, as well as the 
default X,Y and Z rotations 

�� LG3 Limit: to define the value at which the glare curves limit 
will be indicated  

Press OK to confirm modifications, Cancel to exit the function 
without confirming modifications. 

�
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Tool Bar – Menu Bar  
  Notes  

 
Batch Options Window 

Batch Options 
From the Batch Options window it is possible to activate two 
similar procedures for serial export of images and photometric files 
in OXL. 

The luminaire list is selected from the Photowin module and in the 
same module, activation of the batch function is effected by 
clicking with the right  button on the list and selecting the entry 
“Run Batch”. 

In the image creation module it is possible to define: 

�� Saving format: PNG or EPS 

�� Image Output Format: PNG or EPS 

�� Type of graphic to be exported: 

· Polar Diagram 

· Soellner 

· Cartesian 

· Classification 

· Beam�

· Isolux 

· Road Class. 

· Iso-Candelas 

· Luminance 

· Customized 

· Photometric Solid 

�� Image Output Folder: to choose the destination folder. 

The OXL creation module has been added to facilitate FDB 
archive conversion (files which were used until LITESTAR 10) into 
the new OXL files that will be used from LITESTAR 4D version 1 
onwards. 

The key Run Photowin allows you to activate the Photowin module 
(FDB). �

 

The Litepack - OXL 

The Litepack file contains all data regarding a light 
emitting device and has been designed to combine 
the simplicity and  user-frienclly characteristics 
typical of the XML format:, the reasons why it was 
chosen.  

A light emitting device can be a complex element, 
made up of a number of sources of different types 
with lamps in different positions. 

The file therefore contains information regarding 
commercial data, photometric curves, emitting 
surfaces, the object geometry (file 3D) and all 
other technical details required.�
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Tool Bar – Menu Bar  
  Notes  

View 
The View menu allows management of the following functions: 

�� Toolbar to activate or not the toolbar (icon bar); the bar is 
active when • the �  sign appears on the left of the description 

�� Cascade to superimpose the active windows 

�� Tile to place active windows side by side 

 

The menu shows in the lower part the photometries on the list at 
that moment; the active one shows the �  sign on its left.�

 �
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Tool Bar – Icon Bar  
  Notes  

 
Access to function Print Screen Preview  

 
Access to function  Save Image 

 
Access to function  Print Screen 

 
Access to function  Save Text 

 
Access to function  Print All Preview 

 
Access to function  Save Page as 2D DXF 

 
Access to function  Print All 

 
Access to function  Save Page as 2D PostScript 

 
Access to function  Copy Image 

 
Icon to stop the running of the batch procedure  

 
Access to function  Copy Table   

  

�
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Graph and Table Visualization 

  Notes  

After selecting a luminaire and its photometry, if there is more than one available, the program shows the view window where you can 
select from the available graphs and tables to view the photometric matrix. 

The possible options are: 

 

Access to the section showing the general 
luminaire data  

Isolux Diagram viewing and management 

 

Matrix  Intensity management  
 

Isocandelas Diagram viewing and 
management 

 

Polar Diagram viewing and management 
 

Road Luminaire Classification viewing and 
management 

 

Cartesian Diagram viewing and 
management   

Access to Utilization Factors and CIE 
Utilance management functions   

�

Access to photometric Solid management 
functions  

Access to Soellner Diagram management 
functions  

 

Beam Opening Diagram viewing and 
management  

Access to Luminance Diagram management 
functions  

�

Zone diagram and International 
Classifications viewing and management  

Access to SHR parameters (Spacing to 
Height Ratio) management functions of 
emergency luminaries 

 

Access to UGR table management 
functions  

It is also possible, when preset, to access the 
section relative to customized diagrams  
exclusively developed for customers.  

 

�
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General Data  
  Note  

 
General Data 

Here the data of the luminaire, the associated measurement and 
the lamp are visualized. These can be modified to be used as part 
of a catalog.  The window contains the following elements: 

�� Luminaire Pane: this contains general product identification 
data 

· Code – commercial code  

· Name – product identification 

· Archive – family product belongs to 

· Luminaire Dimensions – this opens a window in which to 
enter the approximate dimensions of the virtual box 
containing the product, the bounding box, which will be 
used for the graphic representation of the product in the 
absence of a 3D model.  The variables available depend 
on the shape:  

· Rectangular allows Length, Width and Height values 
to be entered 

· Circular allows the Diameter and Height to be 
entered 

�� Photometric Measurement Pane: this contains the data 
regarding the dimensions of the luminous area that will be 
used in the calculations 

· Luminous Area Dimensions – this opens a window in 
which to enter the exact dimensions of the emitting 
surface: 

· Rectangular allows Length, Width and Height values 
to be entered 

· Circular allows Diameter and Height to be entered 

When insertion is complete the data is visualized in a summary 
string: 

· Upper horizontal luminous area 

· Lower horizontal luminous area 

· Plane luminous area 0° 

· Plane luminous area 90° 

· Plane luminous area 180° 

· Plane luminous area 270° 

· Plane luminous area 76° for road floodlights 

�
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General Data  
  Note  

�� Measurement Pane: this contains general measurement 
identification data 

· Code – measurement code, normally that assigned by 
the laboratory 

· Name – identification of the product 

· Date in which measurement was made 

In the second Measurement Pane (the one below the first) are 
shown the values that identify the photometric laboratory 
operations 

· Symmetry type 

· Maximum gamma angle 

· Yields 

· Maximum intensity 

· Maximum position 

· Measurement distance – this indicates the distance 
between the luminaire and the photometric head; the 
Auto Update flag next to the field allows the photometric 
measurement values to be altered according to the 
variation in the measurement distance 

· Measurement flux – this is the real flux of the lamps 
used for the measurement; the Auto Update flag next to 
the field allows the photometric measurement values to 
be altered according to the variation in lamp flux 

· Operator – identifies the technician who carried out the 
measurement 

· Environmental temperature at the time of measurement 

· Relative Humidity at the time of measurement 

· Photocell used for the measurement 

· Power supply; electrical measurements carried out 
during measurement 

· Current supply; electrical measurements carried out 
during measurement 

�� Notes Pane: this allows several lines to be entered in the 
measurement margin 

�� Luminaire Lamp Pane: this shows the information regarding 
the lamp used in the luminaire for the measurement; press 
the left mouse button to open a context menu presenting the 
following options: 

· View Lamp 

· Modify Lamp 

· Delete lamp 

· Add Lamp 

· Move into other list 

· Copy into other list 

�� Measurement Lamp Pane: this shows the information 
regarding the lamp used in the luminaire to carry out the 
measurements; press the left mouse button to open a context 
menu presenting the following options: 

· View Lamp 

· Modify Lamp 

· Delete Lamp 

· Add Lamp 

· Move into other list 

· Copy into other list 

 

�
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Values and Angles Table (Intensity Matrix)  
  Notes  

The window shows the following elements: 

�� Units: 

· cd: the table values of intensity are shown in absolute 
candela 

· cd/klm: the table values of intensity are shown in candela 
per kilolumen 

�� Display Geometry - this indicates how to graphically visualize 
the measurement semiplanes choosing between: 

· One sided: only the selected semiplane is visualized 

· Headlight: the selected semiplane and its complementary 
are visualized (for example, if the C-45° semiplane  is 
selected, the C-135° will also be shown) 

· Two sided: only the selected semiplane and its 
supplementary are visualized (for example, if the C- 5° 
semiplane is selected, the C-225° will also be show n) 

�� Indication of maximum values and their position – In the 
chart, maximum values are marked with a yellow dot  

 

�� C-Gamma or V-H Photometric Matrix  - The matrix shows all 
the intensity values in [cd/klm]. The corresponding properties 
of each column can be activated by clicking with the right 
mouse button on the semiplane indication. A pop-up window 
will appear that allows you to define: 

· whether the semiplane is active (marked) or not (the 
semiplane indication is reported in the middle at the top) 

· the color of the curve: press on the color box to access 
the window in which to select the desired color, and 
confirm with OK 

· the curve width (thickness): the width can be defined 
either by using the insertion cell or the cursor below. 

To confirm the changes press OK, Cancel to close the window 
without confirming. 

To deselect click again on the plane keeping the CTRL key 
pressed. 

Semiplane selection is limited to 6. To view the selected 
semiplanes, one of the two available diagrams, Polar or Cartesian, 
must be selected. 

�

 



 
 

 

LITESTAR 4D User’s Manual– Rv00 Page. 14/28 

 

 

 

 

Values and Angles Table (Intensity Matrix)  
  Notes  

 

This window allows passage from the photometric curve viewing 
mode to the modification mode known as “Edit mode” .  

In this mode double click to enter a cell and modify the individual 
values of the matrix. 

The following buttons can be found in this mode: 

�� Copy: select the line or column you wish to copy from and 
press the key 

�� Paste: select the line or column you wish to paste in and 
press the key 

�� * Constant (Multiplies by a Constant): to be used whenever it 
becomes necessary to multiply by a preset constant factor the 
matrix obtained from a photometric measurement performed 
with a goniophotometer. This is the case, for instance, of 
factors supplied by certification authorities for the calibration 
of luxmeters when such instruments are not equipped with an 
internal registration system for such a value      

�� + Constant (Add Constant): to be used whenever it becomes 
necessary to modify the matrix obtained from a photometric 
measurement performed with a goniophotometer by adding a 
preset constant factor.   

�� Normalize: to be used if you wish to normalize the matrix 
values. In fact, it could happen that the  �  = 0° values of C- 
semiplanes are different from each other, even if the C-�  
measurement system excludes this possibility. It all depends 
on several factors, such as an imperfect alignment of the 
luminaire on the goniophotometer or slight flux variations 
during the measuring process.  

· If no columns are selected, normalization of the whole 
curve is made on the average of all values at �  = 0°  

· If columns are selected normalization is made on the 
values at �  = 0° of the highlighted columns 

�� = Constant: select the corresponding row or column, select 
the button = Constant, enter the constant value and press 
OK. The program will automatically insert the constant value 
replacing the preceding ones.  

�� Interpolate: select the row or column to which you wish to 
apply the interpolation and press Interpolate. The program will 
automatically apply the square interpolation.   

�� Average: by selecting a row or column, the program will 
calculate the average value of the already existing ones . This 
result will then substitute the previous existing values in the 
selected fields. 

�� Rotate: select the row or column and press Rotate. At this 
point a pop-up window appears in which to insert the value for 
the rotation. If the matrix presents a limited number of planes, 
the program will automatically expand the matrix (insertion for 
the square interpolation of the missing planes) and the 
subsequent rotation. 

�
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Values and Angles Table (Intensity Matrix)  
  Notes  

 
 

�� Copy to…: allows the creation of a copy of the open 
photometric curve with conversions from VH to CG and vice 
versa, changing the density of the photometric map values. 

�� Swap on axis: select the semiplane and press Swap on Axis. 
The program will automatically overturn the measurement 
according to the preset semiplane  

�� right=left: swaps right hemisphere with left hemisphere  

�� left=right: swaps left hemisphere with right hemisphere 

�� Symmetrize to…: creates a symmetrical copy of the open 
photometric curve; the destination curve will be created by 
using the spacing values that have been chosen. Depending 
on the C- Gamma or V-H shape of the photometric 
measurement, the program will present the following options:  

· Drop-down menu for the choice of symmetry (the number 
of possible symmetries depends on the number of 
available semiplanes): 

· CG - 0-180 Symmetric – Copies half the curve using 
the C 0-180 plane as a mirror; 

· CG - 270-90 Symmetric – Copies half the curve 
using the C 270-90 plane as a mirror; 

· CG – double Symmetric – Copies one fourth of the 
curve using the C=0 and C=90 planes to overturn 
the four sectors; 

· CG - rotoSymmetric – symmetrizes with respect to  
C=0 plane.  

· VH - V0Symmetric 

· VH – doubleSymmetric 

· VH - rotoSymmetric – symmetrizes with respect to 
V=0 plane. 

 

· Section on the left with which it is possible to define the 
step of Gamma or V angles and of C or H semiplanes and 
the maximum value of Gamma  

· Section on the right- handside with which it is possible to 
define the data of the new luminaire-photometric 
measurement. In fact, to be able to save the product file, 
it is necessary to modify the Name, Code and File values 
so as to obtain a curve that differs form the original one. 

�
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Polar and Cartesian  
  Notes  

 
Polar Graphs 

The polar and Cartesian graphs are useful for showing the 
intensity values (photometric matrices) in graph form.  

The difference between the 2 graphs depends on the type of 
representation of the data itself. The window elements are: 

�� Indication of the luminaire dimensions in [mm] 

�� Graph representation of the selected C- semiplanes and their 
reference 

�� Indication of the Total Lamp Flux [lm] 

�� the maximum intensity value [cd/klm] and of its position 
according to the type of coordinates • used (C-Gamma or V-
H)   

�� luminous yield [%]   

�� the date of measurement 

�� the type of measurement (symmetrical, asymmetrical ….) 

 

 
Cartesian Graphs 

�
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Photometric solid  
  Notes  

 
Photometric solid 

This window allows three-dimensional viewing of the photometric 
solid which can be rotated to appreciate all its aspects.  

The controls on the panel are as follows: 

�� rotation along X, Y, and Z axes 

�� light power allows variation of the intensity of color with which 
the solid is represented 

�� choice of colors of the photometric solid, the axis from which 
the light derives and the background 

�� view: full color or wireframe 

�� check boxes that allow viewing of: Gamma angles, intensity 
values, beam opening, C-Gamma or V-H axes, luminaire 

�� reset of pan and zoom functions 

The solid can be moved using the mouse by: 

�� keeping the left button pressed to rotate the solid around the 
origin 

�� keeping the right button pressed to move the solid over the 
background 

�� using the wheel to move the solid closer or further away 
(zoom) 

�� by keeping the left button and shift button pressed, the solid 
moves closer or further away (zoom). 

 

 

�
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Beam Diagram  
  Notes  

 
Beam Diagram Representation 

This window allows you to manage the beam diagram graphs.  

The elements it contains are: 

�� Max Height [m]: this is the maximum distance at which to 
measure the beam. It is an edit box and therefore the desired 
value can be entered as required 

�� Maximum Percent [%]:  this is the percentage for the 
maximum value of Gamma =0°, or with respect to the 
maximum intensity axis, according to which the beam 
opening can be evaluated. It is an editable cell in which the 
desired value can be entered   

�� Beam display: here you can select the type of view , whether 
3D View or 2D View according to the C-0/ 80° and C- 90/270° 
plane 

�� Beam Diagram Axes Values: here are shown the values of 
segments OA, OB, OC and OD according to the distance 
from the focal point 

�� Graph and Table: the graphs may be of 2 kinds, 3D and 2D, 
the latter represents the section of the D graphs along the 
longitudinal and transversal planes of the luminaire. The 
graph also shows the semi- spread according to the 2 
principal semiplanes, each pair of which is called Alpha or 
Beta: the pairs of values may also be different according to 
whether the beam is symmetrical ( the Alpha and Beta pairs 
are the same) or asymmetrical (in this case the pairs are 
different). · The table area shows the distance of every single 
calculation plane (5 distances are always taken into 
consideration), the maximum value of illuminance [lux] along 
the beam axis according to the distance and the average 
value of illuminance in the areas subtended by the angle. The 
2D graphs also show the beam diameter [m] according to the 
distance. 

 

�
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Classification  
  Notes  

 
Classification 

This window shows the international photometric classifications of 
the luminaire.  

The elements it contains are:  

�� indication of luminaire yield [%], Total Lamp Flux [lm] and the 
flux emitted by the luminaire [lm] 

�� the DRR (Direct Room Ratio) and RC (Room Class) 
parameters according to the room index (RI) defined by 
CIE52 

�� evaluation of zonal flux, with relative graph, according to 
CIE52 

�� international classifications such as: 

· the CIE flux codes (ref. CIE52) 

· the CIE, German DIN, French UTE and Belgian NBN 
photometric classifications 

�� evaluation of the total flux LOR [%], downward flux DLOR [%] 
and upward flux ULOR [%] 

�� The values of UFF, DFF, FFR, AND RN [%] and BLF  

�
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UGR Table  
  Notes  

 
UGR Table 

This is the UGR Table designed according to CIE 117 norm of 
1995 to check the conformity of the lighting system to the EN 
12464 standard as far as the control of unified glare due to artificial 
illumination is concerned. The UGR index expresses the unified 
glare due to artificial illumination according to the position of the 
lighting devices, the luminance of the walls and from the point of 
view of the users.  

The table allows evaluation of the UGR values in standard 
installation conditions, i.e. in rectangular areas, with a single type 
of lighting device with regular geometry inside the area and from 
the most unfavorable longitudinal and transversal viewpoints.  

The UGR values range between 10 and 30, where 10 corresponds 
to the absence of glare and 30 to considerable physiological glare.  

The EN 12464 standard contains a table of UGR limits for every 
type of environment, only valid however for rectangular areas with 
geometric placing of lighting devices.  

The table is calculated using 0.25 as the default interdistance 
value. If a different value is entered, the table can be recalculated 
according to the new parameter. 

 

�
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Isolux Representation  
  Notes  

 
Isolux Representation 

This is the simulation of a photometric curve by means of the 
isolux representation of the illuminance calculation  in a standard 
environment.  

The results can be visualized on the six walls plus the working 
plane. The contribution of the inter-reflections is not taken into 
account in the calculation. 

Some of the parameters in the window can be modified so as to 
obtain a customized view. These customizations mainly concern: 

�� the dimensions and height (expressed in metres) of the 
working plane of the test environment can be modified 

�� the X, Y and Z position and the X, Y and Z rotation of the light 
emitting device regarding the centre of the area. It is 
necessary in this case to double-click on the coordinates 
shown by the program. At this point a pop-up window will 
appear in which to modify the corresponding data. Press OK 
to confirm.    

�� the choice of the working plane of which to visualize the curve 
corresponding to floor, work surface, ceiling and four walls 

�� the results viewing mode with a choice among absolute, 
percentage and per unit values (in lux)  

The program allows the management of more than a single 
luminaire: just press Add Luminaire to insert a new luminaire by 
using the insertion window in which it is possible to define 
coordinates and rotations. 

In order to modify these coordinates select the Change Position 
button. 

Other parameters are optional: 

�� Text - shows the values in lux in the points where calculation 
has been carried out 

�� Lines - shows the lines of the isolux curves and the relative 
limit values 

�� Shading - shows the state of the illuminances in various 
shades of gray 

�� Max - shows the point or points where the maximum 
illuminance values are to be found 

�� Luminaire – shows or hides the drawing of the luminaire  

�� Grid - shows the dimensional grid 

�� Line numbers - shows or hides the values on the isolux graph 

Advanced options – customized printing and screen preview 
parameters (see advanced Options for Isolux and Isocandela). 
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Isocandela Representation  
  Notes  

 
Isocandela Representation 

Representation of the movement of the isocandela values of a 
photometric curve through different kinds of projection.  

It is possible to intervene dynamically both on the inclination and 
on the rotation of the lighting device. 

The window allows configuration of the following settings: 

�� Lumin. Angle – this is the inclination angle of the luminaire 
around the horizontal axis passing through its own luminous 
center and parallel to plane c 0-180° 

�� Lumin. Rotation Angle – this is the rotation angle around the 
vertical axis passing through the centre of the luminaire 

�� Value –this is the view mode of expressing the values of the 
curves between absolute values or percentages 

�� View – a drop-down menu allows you to choose among the 
following options: 

· all - represents the whole hemisphere 

· upper - represents the upper part of the hemisphere 
which corresponds to indirect lighting 

· lower - represents the lower part of the hemisphere 
which corresponds to direct lighting 

�� Projection – a drop-down menu allows you to choose among 
the following options: 

· orthographic 

· equivalent - in accordance with CIE 31-34- norms for 
representing roads photometries, with indication of throw 
and spread values 

· stereographic 

· sinusoidal 

· Cartesian 

For each of these representations, the maximum value, throw 
value and level curve values can be shown. 

�� Advanced options – customized printing and screen preview 
parameters (see advanced Options for Isolux and 
Isocandela). 
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Advanced options for Isolux and Isocandela  
  Notes  

 
Advanced options for Isolux and Isocandela 

Clicking on the Advance Screen Options button, both in the Isolux 
and Iso-candela tabs,  a window as shown on the right will be 
displayed. The user will be able to configure the following settings: 

�� Number and color of levels: double-click on the value 
displayed on the list on the left to activate the window where 
the value and number can be set 

�� Automatic Level Setting – in this section the following items 
can be set: 

· Min – the minimum value of the first curve to be drawn  

· Max – the maximum value of the last curve to be drawn 

· Delta – the step between one curve and the following  

This section includes also the Make Levels and Default 
Levels buttons. The former allows you to set values that can 
by applied (the list on the left is subsequently updated 
automatically), whereas the latter can be used to reset the 
default levels 

�� Shift between automatic/manual values 

�� Color settings  

· Background Color 

· Isolux Text color between Same as Isolux or Fixed: in 
the former case the color set for each curve is used, 
whereas in the latter, one of the colors chosen will be 
used for all texts 

· Lux Text Color 

· Shading Dark Color 

· Shading Bright Color 
 

 

By double-clicking on one of the available values a window where 
the user may set the value and color of the curve will be displayed. 
Press OK to confirm. 

The window shows the following buttons: 

�� Add Level… to add a new level to be displayed 

�� Set Optimal Colors For Screen to load the default optimal 
colors palette for the screen display 

�� Set Optimal Colors For Printing to load the default optimal 
colors palette for the printouts 
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Roads Classification  
  Notes  

 
Roads Classification 

This window manages the utilization factors for road luminaires. 

In this window the following settings can be configured: 

�� Lum Tilting Angle - command for modifying the inclination of 
the light emitting device. A frame in the graph gives the visual 
perception of this inclination 

�� X coordinate units - The graph shows the utilization factor 
lines divided into sidewalk side and road side. These data can 
be presented as the ratio between distance and height or 
expressed in angles 

Below the graph the following values regarding the light emitting 
device are shown: 

�� indication of the Throw and Spread value 

�� SLI index 

�� CIE classification 

�� IES classification 

�� DLOR 

�� ULOR 

�� total yield 

�� RN value 

�� glare index 

�� class of luminous intensity 
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CIE Utilization and Utilance Factors  
  Notes  

 
CIE Utilization and Utilance Factors 

This window manages utilization and utilance factors in ac-
cordance with CIE52.  

The elements contained in it are: 

�� Calculation Type – choice between utilization and utilance 
factors 

�� Distance Luminaires/Ceiling in [m] – editable field 

�� Distance Luminaires/Working Plane in [m] – editable field 

�� Suspension Ratio meaning the ratio between the distance 
luminaires/ceiling and that between luminaires and working 
plane 

�� Distance Working Plane/Ceiling in [m] 

�� Mounting – choice between direct luminaires (downward light 
emission) and indirect (upward light emission) 

�� Normalization - choice between normalized and non-
normalized 

�� Calculation Surface - this is the surface on which calculation 
of the factors is to be made and can be selected between 
walls, ceiling and working plane (generally only the last is 
used) 

�� Utilization/Utilance Factors Matrix according to set 
parameters, reflection factors of ceiling, frieze, walls and floor 
and K index. Clicking on one of these four reflection factors 
opens the window with which to modify the factors. Use then 
Save config…. to save the modifications giving the new series 
a distinguishing name (the configurations of saved values can 
be loaded by using Load config …., use CIE default Values to 
load the standard CIE series)  

The index can be edited by clicking on the K value.  

Then the interdistance ratio values between luminaires and height 
of installation are shown. 

The window also shows the following buttons: 

�� Save Config. to save a configuration set by modifying the 
values in the factors matrix 

�� Load Config. to load a configuration of K indexes and  
reflection factors previously saved 

�� Set CIE default values to load the default values in 
accordance with CIE Recommendations 

 

The lower part also shows the SHR (Spacing to Height Ratio) 
values in accordance with the American norm LM53. 
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Söllner Glare Diagram  
  Notes  

 
Söllner Glare Diagram 

This window manages the Söllner Glare Diagram in accordance 
with CIE55.  

The elements contained are: 

�� Luminance values table in cd/m2 for each angle 

�� CIBSE VDT Classification 

�� Söllner graph 

�� Graph visualization according to models A and B 

�� Set Luminance Limit –  this opens a window where the user 
can set the limit values for the luminance curves, the limit 
angle and the label to identify such a limit. Two buttons allow  
the modified values to be saved in the configuration file or to 
load the previously saved values. 
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Luminance  
  Note  

 
Luminance 

The screen shows the luminance values of the photometric solid 
expressed in the CG system.  

The C planes have spacing of 10° while the g angles  have steps of 
5° between 0° and 45° thereafter of 1 degree. 

The screen shows a window divided in two different sections: 

�� The first, on the left, displays the values expressed in figures 

�� The second, on the right, shows the C semiplanes displayed 
as a polar diagram. 

By selecting a line of G angle values, the luminance value graph 
can be viewed.  

It possible to set the values of color, line type (full, broken, dotted), 
line thickness for each line of the graph. 
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Emergency Spacing  
  Notes  

 
Emergency Spacing 

Calculation of the inter-distances between luminaires for 
emergency lighting calculation according to norm EN 1838. 

Calculation is carried out by positioning the luminaires at different 
heights and proposing the results according to the spacing 
patterns shown on the right of the table.  

The A, B, C and D inter-distances concern the escape routes; 
calculation is carried out in the norm corridor of a width of 1m. 

The E, F, G and H inter-distances concern the anti-panic areas; 
calculation is carried out excluding 0.5m along the walls. 

The red cells indicate that min/max uniformity is less than 40:1and 
therefore the values are non-compliant, while the colors of the 
other cells are used only to improve legibility. 

 

In the lower part of the screen there is a graph outlining the lux 
results of two luminaires.  The editable fields here allow interactive 
variations to the graph:: 

�� Hm: installation height 

�� C Plane: indicates the rotation of the C planes on the axis 

�� Distance: between two luminaires 

The values are all expressed in meters 
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